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Introduction

As scientists, astronomers do not only take pretty pictures, but also must produce
quantitative (mathematical) analyses of these pictures. There are many different
methods for analyzing astronomical images, and therefore many different software
tools for doing this analysis.

This guide provides instructions using a program called ImageJ. The advantages of
this program are that it is Java-based (so it can run on any computer), it is free,
and it is relatively user-friendly.

The guide begins with instructions on how to download ImageJ plus some additional
astronomy-related plugins, followed by directions on how to install everything
correctly (for both mac and pc). After you have everything installed, there are 3
lessons that will help you get oriented with some of the most basic image
processing skills needed for analyzing astronomical images. There are questions
throughout the lessons to help guide your thinking (the answers are provided at
the end). After the 3 lessons is an explanation for how fo create a color picture
using 3 different grayscale images.

Many of the lessons require some supplementary materials. They're found at:
http://cse.ssl.berkeley.edu/cms/Imaged GuideMaterials/tabid/305/Default.aspx
Many of these files are pretty large. It is recommended to access them with a
high-speed internet connection.

Finally, some technical notes. Both ImageJ and the Astronomy plugins mentioned in
this guide are frequently updated. The functionality and appearance of the
programs may be different now compared to when these instructions were last
updated (Spring 2010). However, the basic ideas and processes should remain
basically the same. Also, the screenshots in this booklet were all taken on a
MacBook. If you are usinga PC, things will look slightly different. The most
significant difference is that the menus will appear in the ImageJ windows instead
of at the top of the screen.

NOTE: It is highly recommended to use Mozilla Firefox as your
web browser. If you have problems with files not downloading or
working correctly, please try using Firefox:

www. mozilla.com
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Installing ImageJ and Astronomy Plugins

Goals: In this section, you will download and install ImageJ and the astronomy
plugin tools.

Imaged is a free, Java-based image processing and analysis program published by
the National Institutes of Health. The program should work on any modern PC or
Mac with Java. The ImageJ astronomy plugin package was authored by Dr.
Frederic Hessman at the University of Gottingen. These tools were designed for
use by classrooms and teachers for data taken with the MONET ftelescopes.

Downloading and installing ImageJ with all required tools:

1. Go to this website:
http://rsb.info.nih.gov/ij/download.html

2. Install Imaged to your computer.

a) Make sure you know what operating system you are using on your computer.
b) Simply follow the installation instructions after you click on the hyperlink to
download the program.

¢) Run ImageJ just tfo make sure it is working on your computer.

Next, we need to install all the tools that you will need for observing and
analyzing...

3. Go to this next web page: [DO NOT POST THIS ON A WEBSITE]
www.astro.physik.uni-goettingen.de/~hesman/ImageJ/Astronomy/

4. Download the zip file entitled 'Astronomy.zip' to your desktop.

5. Unzip the file on your desktop. We will be moving some files around, so you will
need to know where items are located as o make for easy accessibility.

6. Double click on the 'Hard Drive' icon if you are using a mac, or go to '‘My
Computer’ if you are using a PC in order to open an "explorer" box so that we can
move files around.

7. Double click on the 'Hard Drive'/'My Computer' icon again to open a SECOND
"explorer" window.
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a) In one window you want to be able to look at ImageJ and its files and in the
other window you want to be able to look through the astronomy folder that you
unzipped.

8. Double click into 'Astronomy’ folder from the desktop in either one of the two
"explorer" windows.
a) you should see two folders, 'plugins’ and ‘macros’.

9. Double click into the 'plugins’ folder.
a) you should see four items.

10. In your 2nd explorer window double click on 'Applications’ folder, or if you are
using a PC, the 'Program files' folder.

11. Please navigate to and double click on the 'TmageJ’ folder.
a) you should be able to see all of the folders and files within 'ImageJ’ including
one folder in particular labeled plugins.

12. Look BACK at your other "explorer" window (the 'Astronomy’ folder that you
just unzipped)

a) Highlight the four items within the unzipped 'Astronomy’ folder. (astroj.jar,
astronomy folder, astronomy__.jar, and CCD folder)

13. Drag those four items into the 'plugins’ folder of Imageld.

Part 1 donel!

14. Within the folder that you downloaded ‘Astronomy’ there were two folders,
click into the other folder now, the 'macros’ folder.

a) you should see a sub folder labeled 'toolsets’.

b) double click into 'toolsets’.

c) you should see a file labeled ‘astronomytools.txt".

15. Make sure you still have open your two explorer windows... one looking into

applications within ImageJ, and the other explorer window looking at
"astronomytools. txt"
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16. In your first explorer window (looking at ImageJ files), double click on the
folder labeled 'macros’.
a) you should see several sub folders, one of which is labeled ‘toolsets'.

17. In your second explore winder the one looking at ‘astronomytools.txt’,
highlight ‘astronomytools. txt'.

18. Drag ‘astronomytools.txt’ over to the other explorer winder and place into the
folder labeled 'toolsets'.

19. If Imaged is running restart it. Or if it was not running just start it up by
double clicking on its icon. I

Now to get those tools up o the tool bar!

(ImageJ should be running)

20. Click the > icon on the far right side of the ImageJ toolbar.
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21. In the pulldown menu that appears, click on ‘Astronomy Tools'.
a) several of the toolbar icons will change, now appearing like so:
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Now we have one more application to install, and it is a very important one because
it will allow us (among other things) to focus the telescopel...

22. Close Imaged.

23. 6o to http://math.nist.gov/ javanumerics/jama/Jama-1.0.2.jar in your browser.
This link will download a file named Jama-1.0.2.jar

24. Tt most likely will download to your desktop, but wherever it downloads make
sure you know where that is. Now, please open an "explorer" window by double
clicking the hard drive symbol (mac) or going to ‘My Computer’ (pc).
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25. Double click applications folder.
26. Double click ImageJ folder.
27. Double click on the Plugins folder.

28. Now, click and drag the Jama-1.0.2.jar file into the folder labeled 'Input-
Output’.

30. Pat yourself on the back. You are finished loading all of the tools!
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Lesson 1: Digital Picture Basics

Goals: In this lesson you will learn some basic vocabulary about digital pictures.
You will also open a picture with ImageJ and relate this vocabulary to the picture.

Materials: You need a computer with ImageJ installed, and the digital picture

kermit.jpg (found at:
http://cse.ssl.berkeley.edu/cms/ImageJGuideMaterials/tabid/305/Default.aspx)

or a digital picture of yourself or someone you know well.

Here is some basic vocabulary that will re-appear throughout our work with
astronomical images:

Pixel — A "pixel” (short for "picture element") is the smallest unit of a
digital picture. These are little squares arranged in a grid to create a
full picture, like a mosaic.

RGB/Grayscale — "RGB" stands for "Red, Green and Blue.” Monitors
display colors using red, green and blue light; combinations of these
three colors create all other colors. Color digital pictures are usually
stored in RGB format. “Grayscale” is the same as what most people
would call "black and white." Another common color scheme is "cmyk"”
(cyan, magenta, yellow and black); cmyk is used by color printers.

Pixel Value — The pixel value indicates how bright each color is ina
pixel. Most grayscale images use a value between O (pure black) and
255 (pure white). For RGB images, each color is assigned a value
between O and 255. A pixel with R=255, 6=0, and B=0 will be a bright
red pixel. A pixel with R=255, 6=0, and B=255 will be purple (bright
red plus bright blue).

Look-up Table (LUT) — A look-up table, or LUT, relates the pixel value
to what is displayed on the screen. If you change the brightness or
contrast of an image, you are altering this relation, but not the image
itself. Think of it like changing the brightness or the tint on your
television set. Twiddling with those settings changes the picture that
you see, but the signal coming from the TV station is not changed.

Activity: Explore these terms in relation o a real image
1. Find a color digital image to work with. For the activities below, we'll be
exploring how images change as we mess with colors, brightness and
contrast. Find a picture of someone you know very well, so you can
readily see how these changes affect the picture. If you don't have a
picture, use the picture of Kermit the Frog.
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2. Make a copy of this image. We don't want o mess up your only copy of a

perfectly good image, so make a copy of the image file, and put the copy
where you can find it.
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e The picture should pop open.
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4. Move the mouse around over the image. As you do this, look at the
Imaged tool bar. You should see numbers like "x=106, y=214,
Value=77,80,25." These are the x and y coordinates of the pixel your
mouse is over, and the pixel value(s) for that pixel. The three values tell
us that this is an RGB image, and the individual numbers say that the
pixel has a moderate amount of red, a moderate amount of green, and
little blue (remember that these values range from O to 255). In reality,
the pixel is olive green.

As you move the mouse, the x and y coordinates and the pixel values will
change.
e Move the mouse over areas of different colors. Do the changes in
the pixel values make sense, depending on the color you are seeing?
e Inwhich direction do the x coordinates increase? They
coordinates?
e Look at the pixel values for a nearly-white pixel. Do these values
agree with the convention that the maximum pixel values are 255?

5. Zoom in many times. There are three ways to zoom in. You can either
use the menus for "Image” > "Zoom" > “In", or you can click on the
magnifying glass in the toolbar and then click on the image, or you can use
the + and - keys. Keep zooming in until you reach the maximum zoom.

e Can you see the individual pixels?
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Convert the image to grayscale (black and white). Because astronomy
images are in grayscale, and because grayscale is a little easier to
understand, let's convert your color image to grayscale.

In the ImageJ menus, go to "Image” > "Type" > "8-bit." Voilal

Move the mouse around inside an individual pixel. Note how the x
coordinate, y coordinate, and pixel values do not change. This is
because a pixel is the smallest unit of a digital image.

[ C Image) File Edit Image Process Analyze Plugins Window Help
80"“’ Image)
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x=106, y=214, value=77,80,25

kermit.jpg (3200%)
386x480 pixels; RGE; 724K

Your image is in grayscale.

Save the image with a different name: “File” > “Save As" >

"Tpeg.."
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7. Move the mouse over the grayscale image. Note that the pixel
coordinates are unchanged, but the Value is now a single number.
e What pixel values correspond to dark areas? What values to light
areas?

8. Change the brightness and contrast. "Brightness” and "contrast” are
controls that allow you to change the look-up table, but not the pixel
value.

e Open the Brightness & Contrast dialog box. Use the menus
"Image” > "Adjust” > "Brightness/Contrast”

£8C
Show Info... Window/Level...
A A el Properties... Color Balance...
386480 pixels; 8-bit; 181K Color Threshold...
Stacks Size...
Hyperstacks Canvas Size...

Crop
Duplicate...
Rename...
Scale...
Translate...
Rotate
Zoom

Lookup Tables

Minimum
Maximum

Brightness
Contrast

(" Auto )( Reset )

( Set )( Apply )

e Slide the bars controlling brightness and contrast around. What is
the difference between adjusting the brightness and adjusting the
contrast?

e C(lick "Reset” to go back to the default settings.

e Zoom in as far as you can on part of the image. Find a single pixel
to follow. What is its x and y coordinate? What is its pixel value?

e Move the brightness and contrast bars drastically.

e Move the mouse back to the same pixel. Use the x and'y
coordinates to make sure you have the right pixel. What is the
pixel value?

e Move the brightness and contrast bars again. Relocate your pixel.
What is the pixel value?
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Brightness and contrast change how the image looks on the screen,
but do not affect the pixel value. However, if you save the
adjusted image, many computer programs will change the pixel
values so that the picture looks the same the next time you open it.

9. Set some specific value ranges. The brightness and contrast dialog box
also allows you to set specific value ranges to display. Values higher than
the maximum appear as pure white; values less than the minimum appear as
pure black.

Zoom back out so you van view the entire image.

In the brightness and contrast dialog box, click on the button
labeled "Reset.” Your picture should go back to the normal
grayscale.

In the brightness and contrast dialog box, click the button "Set."
Another dialog box will appear.

Set the minimum value to 50, and the maximum to 100. Click "OK."
What happens?
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Move your mouse over pure white and pure black areas. Look at
the pixel values. Are they outside your minimum and maximum
range (they should be)?

Now, click on the "Set" button again. Set the minimum value to -
100, and the maximum value to 350. Click "OK." What happens?
Click on the "Reset"” button; your picture should be back to normal.
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e Zoom in as far as you can and look at a single pixel; note the pixel
value.

e Play around with the minimum and maximum and the brightness and
contrast buttons. Convince yourself that the pixel value does not
change no matter what you do with the brightness, contrast,
minimum and maximum. You are changing how the image is
displayed, not the image itself.

Points to take away:

e Digital images are made of individual pixels. A pixel is the smallest part of a
digital image.

e Each pixel has an assigned coordinate and a pixel value.

e Color pictures need three values for each pixel. These values describe how
much red, green, and blue light are present in each pixel.

e Grayscale pictures need only one value for each pixel, describing how bright
each pixel is.

e Changing the brightness and contrast does not change the pixel value.

Some questions to think about:

e Brightness and contrast change the mapping of pixel values to the displayed
shade of gray, but those values are unchanged. Why do astronomers like
this property?

e Most astronomical cameras create images with pixel values as high as
65,535. ImageJ will map these counts to look-up tables that run from O to
255. If you have faint stars with pixel values of only 155, you won't be able
to see them in ImageJ's display. How can you use ImageJ fo see these
stars?
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Lesson 2: Opening an Astronomical Image
Goals: In this lesson, you will open an astronomical image, adjust its brightness and
contrast, and learn how to invert an image and why.

Materials: You will need your laptop with ImageJ installed and the image file
quintet.fits, downloadable from
http://cse.ssl.berkeley.edu/cms/Imaged GuideMaterials/tabid/305/Default.aspx

1. Look at the file name. The ".fits" means that the image is a "FITS" file. "FITS"
stands for "Flexible Image Transport System.” FITS files are one of the
standard image types for astronomical research images.

2. Opening the image file. ImageJ opens FITS files the same way as other image
types: "File" > "Open". Browse for the file, find it and click it!

v
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This picture is of Stephan's Quintet, a group of four related (and one unrelated)
galaxies. Can you see five galaxies in the image? We can't.

3. Run your mouse over the image and look at pixel values. Remember how the
grayscale image from Lesson 1 had pixel values between O and 255? FITS
images can have arbitrary pixel values. This allows astronomical cameras to
count individual photons; many astronomical cameras can go as high as 65,535.
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When you open a FITS file with ImageJ, it displays the highest pixel value as
pure white and the faintest pixel value as pure black. This means that the
faintest objects are displayed as only slightly less-black pixels, which your eyes
have trouble seeing. So, the galaxies are there, but they and other faint
objects are hard tfo see.

What can you do to make fainter pixels easier to see?
4. Adjust the Brightness and Contrast. Remember, to do this click

"Image” > "Adjust” > "Brightness/Contrast”. The Brightness and Contrast
window will pop up.

) O B&C
There are three ways to choose the brightness and contrast:
"I The first and easiest way to adjust the
brightness/contrast of the image is to click on 171.86 31569.!
the Auto button. This button will automatically = = mm—
adjust the image to ImageJ's best guess at optimal « O
values. It's usually wrong, but not awful. | Madmum
7] The second way to adjust the brightness and Brightness
contrast is to slide the minimum, maximum, .~ - i
brightness and contrast bars until you can see faint
objects. This is easy to do, but hard to dial in, and (_Auto )(_Reset )
probably the most frustrating and least productive ( Set )( Apply )

method.

71 The final and bet way is to manually set the minimum and maximum values.
Press the Set button, and a dialogue box will open allowing you to set the
minimum and maximum displayed pixel values. In any astronomical
picture, most of the pixels will be blank sky. So, move your pointer
around the picture and look for the lowest typical pixel value (in the case
of quintet.fits, I would guess it is around 350. Do you agree?) Set that
to be the minimum. Then, a good starting guess for the maximum is to
add 500 to the minimum value (850 here). Click OK. Can you see the five
galaxies now?
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Remember from Lesson 1: changing the brightness and contrast does not
change the pixel value, it only helps you to see the image better. So feel
free to adjust the brightness and contrast however you want.
Remember, the goal is to see faint objects - the bright ones will always
be visible as pure white pixels!

5. Invert the image. Your eye is very good at picking out slightly off-white colors
on a white background, while not so good at picking out slightly less-black colors
on a black background. (This is why if you spill coffee on white shirt you rush to
change it, but you don't need to change if you spill coffee on a black shirt.) The
same is frue for picking out faint stars or galaxies in an astronomy image. If
you could make the sky white and the stars black, you could pick out fainter
objects.

Although the Universe doesn't provide us this convenience, ImageJ does. To
make your life easier, you can invert (“flip”) the image so that you are seeing
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black stars on a white background. To do this click: Image > Lookup Tables >
Invert LUT.
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Important! Do not use Edit - Invert, because this changes the pixel values!!

Another example of an inverted image is shown on the cover of this booklet.
Half the image is normal, and half is inverted. Note how much more detail you
can see in the faint nebula in the inverted half!

Play with the brightness and contrast some more to bring out faint features.
To get the best results from the inverting process, you will probably need to
adjust the brightness and contrast some more. Personally, we like a light-gray
background; we obtained best results by using the SET button and setting the
minimum to 300, and the maximum to 475. Play around and see what different
values do! Can you see the faint arms extending far beyond the galaxies?
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Conclusion: By now, you should be familiar with the process of opening an
astronomical image with Image J. You should be able fo use the brightness and
contrast in order to make faint objects more noticeable. Finally, you should be
familiar with the process required to invert an image.

Be patient; FITS images are big and can take a while to download.

For a real challenge, download the image of the Draco Dwarf Spheroidal galaxy.
Most of the stars in the image are stars close to us, but there is a collection of
extremely faint stars foward the center of the image that make up a very small
neighbor galaxy to our own Milky Way. Can you see them? You will have to adjust
the brightness and contrast to bring out the faintest stars. Then, zoom in and
compare the density of faint stars at the middle of the picture to the density at
the edges of the picture.
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Lesson 3: Measuring Star Brightnesses
Goals: In this lesson, you will learn to use ImageJ to measure the brightnesses of
stars in an astronomical image.

Materials: You will need your computer with ImageJ software installed. You will
also need the image file ngc7063_u.fits from
http://cse.ssl.berkeley.edu/cms/ImageJGuideMaterials/tabid/305/Default.aspx

First, some background. Astronomical cameras count the number of photons of
optical light coming from an object. The pixel values in FITS files are proportional
to the number of photons a telescope collected during the exposure. But the
number of photons collected from a star can vary, depending on how big the
telescope is, what the weather is like, and the quality of the camera.

So astronomers have adopted a brightness measure called "magnitudes,” based
loosely upon a classification system from the ancient Greek astronomer
Hipparchus. The magnitude system is logarithmic, such that a difference of five
magnitudes means a factor of 100 difference in the number of photons detected.
But the magnitude system is backwards, such that fainter stars have larger
maghitudes. Think of it like a ranking system - just as 1°" place is better than 2™
place, 1" magnitude is brighter than 2" magnitude.

The steps for determining the magnitude of a star from an image are
straightforward, if not always simple. First, you measure how many photons
arrived from a star. Second, you apply one very simple mathematical equation to
put the star on the magnitude system. And that's it!

The way we measure how many photons arrived is by a method we call aperture
photometry. This means that we draw a shape around a star and count all of the
photons the landed inside that shape, then we subtract off the number of photons
that land inside an identical shape in a blank part of the sky. The ImageJ
astronomy plugins have a tool that automate this for you.

Let's see how to do this in ImageJ using the file ngc7063_u.fits, a picture of the
wimpy star cluster NGC 7063 taken at Lick Observatory outside of San Jose, CA.

1. Open the image in ImageJ and adjust the brightness and contrast so you can
see faint stars. If you need a reminder how to do this, review Lesson 1 and/or
Lesson 2. Here's what I see:
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Simple but Important Thought Questions: What shape are the stars? Zoom
in, if needed, to get a clear view. If we want to measure all of the light
coming from a star, what shape of measuring tool should we use?

2. Load the Astronomical Tools. Now that we are going to be measuring stars, it's
time to load our astronomical tools. To do this, click on the >> icon on the far
right of the toolbar, and select "Astronomy Tools”. This will change some of
the icons on your toolbar:

C?r:&-‘#‘-\AQ@/@“!S‘EW!ﬁ 4| & _

Switch to alternate macro tool sets
; Astronomy Tools

Drawing Tools
Example Icons
Lookup Tables
Plugins

Stack Tools
Toolset Creator
Help...
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3. Select the aperture photometry tool. Since stars are circles, we want to
measure how bright the stars are using a circular region; this is called aperture
photometry. The icon of the blue smudge inside a red circle is the Aperture
Photometry Tool. Double-click on this icon to open the aperture photometry
dialog box:

® Image)
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Image]
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Aperture Photometry Tool

000 ngc7063_u.fits (50%) OO0 Aperture Photometry Parameters

HAJee| | | |»

1024x1024 pixels; 32-bit (inverting LUT); 4MB

i : i Radius of object aperture ' 17.00

il : 7 e | Inner radius of background annulus ' 19.00

Outer radius of background annulus 23.00

e Iy L d '. \ ™ List centroid position
i } ; 2 .. aperture and background brightness
... Julian Date of image (if available)
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.. mean moment width
.. the decimal values for the FITS keywords called...
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OO000®&

Comma-separated keywords: TEL-FOCU
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& ! SN -, "] Use the clicked position, do not reposition
i . : G S b [ Clear ROI after use
b T AERE i ¢ ] Clear overlay before use
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Sl s ‘: ( Cancel ) ( OK )
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4. Set the aperture photometry parameters.

] Set the object aperture radius. Although brighter stars look bigger
in the pictures, each star's light extends out the same radius. (Trust
us on this. If you don't believe us, and it is natural if you don't, we can
prove this to you at the workshop.) Therefore, we must measure each
star's brightness with the same size of circle. Zoom in on a bright star
and put your cursor at the center. Look at the x and y position for
that pixel. Now move the cursor to the visible edge of the star. Get
the new x and y positions and calculate the radius. (For our image, I
get 8 pixels, though 6-10 would be acceptable answers.) Believe it or
not, it is far more important to be consistent than to be right. So,
pick a radius, enter it in the "Radius of object aperture” box, and
leave it alone. For now, let's choose 8.

1 Set the sky annulus. Despite what you might think, the sky is not
completely dark. There is faint light everywhere from stars too faint
to see, from bright stars outside the field of view, from the moon (if
it is up), and even from glowing air high in Earth's atmosphere. We
need to measure how bright the sky is and subtract it off.
Thankfully, the astronomy tools will do that for you. The tool will
measure the brightness of the sky in a ring (annulus) around the star.
We need the ring to contain enough pixels to allow a good
measurement, but not so large as to contain other stars. Typically, we
set this ring to have an inner radius a pixel or two larger than our
object radius, and set the outer radius to four or five pixels larger.
Set the inner radius to 10 and the outer radius to 14.

1 Set the output values. What information do we want to know about
each star? We need the x and y positions of a star (called the
“centroid”), so we can find it again, so be sure the "List centroid
position” box is checked. We also need to know the total amount of
light from the star, so check the "...aperture and background
brightness” box. It's also nice to draw a circle around each star, so
that you know which stars you've measured, so check the "Display
object aperture in overlay” box. And, if you want to make sure that
there aren't other stars in your sky measurement, click on the "...sky
annulus in overlay” box.
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1 Click OK.

< MOV Aperture Photometry Parameters

Radius of object aperture 8
Inner radius of background annulus | 10

Outer radius of background annulus | 14

™ List centroid position

. aperture and background brightness

... Julian Date of image (if available)

. world coordinates (if available)

. mean moment width

. the decimal values for the FITS keywords called...

O000®&

Comma-separated keywords: TEL-FOCU

4 Display object aperture in overlay

... sky annulus in overlay

[ ... wvalue as label in overlay

[ Use the clicked position, do not reposition
[] Clear ROI after use

[ Clear overlay before use

[] Show ather configuration panel

Ir Cancel N'I Ir oK “'I

5. Measure how bright the stars are. Now you are ready to go. Zoom in on your
image so you have a good view of some stars. To measure the brightness of a
star, just click on it. ImageJ will try and center a circle on your star, draw a
circle around it, and pop open a dialog box with the star's x- and y-coordinates,
the star's brightness (with the sky already subtracted), and the sky brightness.
If you click on multiple stars, you will get multiple measurements:
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6. If you click in the wrong place, don't panic. My star 5, the circle on the faint
star in the lower left part of the frame, didn't center right. That's because of
an even fainter nearby star. This means I probably have a bad measurement on
this star. Also notice my star number 6 has negative counts; that's because I
clicked on a part of blank sky (that's the circle in the middle of nowhere in the
lower right). When this happens, make a note that you need to ignore those
data points. We'll delete them later; you can keep measuring stars in other
parts of the image for now.

7. Export your data for use in a spreadsheet. At the workshop, we are going to
want to do math with the star brightnesses, and we will need to import these
numbers into a spreadsheet. Thankfully, ImageJ makes exporting these data
easy.

1 Click on your results window to highlight it.
71 Inthe ImagedJ menu, select "File” - "Save As"
] Save it as a .xls file (for Excel).
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Conclusions: After completing a run through this lesson, you should be able to
determine the sizes of stars in your image, to adjust the radii of your star
aperture and sky annulus, to obtain measurements of the positions and source
counts for multiple stars, and to save those data to a file.

Additional questions and exercises for the diligent student: If you finished these
lessons and feel comfortable, here are a few things that you can be thinking about.
If your brain is hurting and you don't want to think any more, don't worry.

What would happen to your number of counts if the camera shutter had

been open twice as long?

Open the results file you saved above in your favorite spreadsheet. Turn

your star photon counts into raw magnitudes. The formula for magnitudes is:
m=c-2.5xlogio(source counts)

where c is a constant that depends on the telescope, the length of the

exposure, and the particulars of the camera. For this image, c=23.02.
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Making Pretty Color Pictures

Goals: In this lesson, you will learn to use ImageJ to create a color image from
individual images of an object taken through different filters.

Materials: You will need your computer with ImageJ software and astronomical
tools installed. You will also need the image files M16B.fits, M16V. fits, and
M16R.fits from the workshop website.

Before beginning this worksheet, read the NASA/Hubble Space Telescope website
http://hubblesite.org/qgallery/behind_the pictures/meaning_of color/. The
important points to keep in mind from this site and from activities during the
workshop are:
CCD cameras take black and white images.
Color images are produced by combining the black and white images taken
through different color filters.
Most images of nebulae and galaxies are color-enhanced, meaning that subtle
shades of color are brought out to produce an aesthetically pleasing picture.
Your eye would see just a milky white color, even if you were really close to
the object.
In other words, in producing a color image, we are leaving the realm of science and
entering the realm of art. For that reason, the instructions below are generally
not quantitative. You should feel free to play around with images until you think
the result is pretty.

Many people feel uncomfortable with this; they tend to want pictures that
replicate what the human eye would see. If you feel this way, please reconsider.
No camera ever built reproduces exactly what the human eye sees. Some are
closer than others. But we can and do learn a lot from pictures that are not
"exact,” like black-and-white pictures, sepia-toned pictures, and old color pictures
where some colors have faded.

The color astronomical picture you will produce in this lesson is like that. In
addition to aesthetic qualities, the colors are telling us something scientific, that
conditions in one area are not identical to conditions in another area. What do the
different colors mean? Answering that question leads one from art back into
science.

So, how can we make color pictures? Let's return to our friend, ImagedJ.
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Open the images of the same object with ImageJ. You will need three images, one
through a bluer filter, one through a redder filter, and one through an
intermediate filter. These are typically labeled "B” (blue), "V" (green), and "R"
(red).

For this exercise, we've provided images taken with a 0.8-meter telescope of
the Eagle Nebula, Messier 16 (a.k.a. the "Pillars of Creation” from Hubble),
taken through the B, V, and R filters. Use ImageJ to open each image so you
have three open images.

roo
@ Image)
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Qo =<4+ [N A|Qf@ 2| ®|oxjsujur 7| | 8|0 |>»

M168B.fits (25%)
2x2045 pixels; 32-bit; 16ME
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M16R.fits (25%)
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f g,,@ imagej_color ¥ Q

= h Name & Date Modified
% lagosuchus M m16.wgb Today
9 Newwork _ m16_rgb2 Today
4 e _ ml6_rgb3 Today
1 Macintosh... (e m168.fies 9 Jul 2008
£ MI16R.fits 9 Jul 2008
il Desktop f m16v.fits 9 Jul 2008
A!)\ Kurtls
'\ Documents
//\_ Applications
6 Music
observing
New Folder ) ( Cancel ) € Open )
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1. Convert each image to a logarithmic stretch. CCDs take linear images, such that
each incoming photon is furned into a set number of image “counts.” However, a
logarithmic stretch is generally preferred, because this brings out faint
objects while still allowing your eye to discern brightness differences in bright
parts of the image. In fact, your eye uses logarithmic stretch, as does
photographic film. Digital cameras convert most pictures to a logarithmic
stretch before displaying them.

To get a logarithmic stretch in ImageJ, click on the "B"-band image and select
Process —Math —Log. Repeat the process on the "V" and "R" image.

Note: converting to a logarithmic stretch also essentially corrects for exposure
time and sensitivity differences.
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2. Open the RGB composer. This is a plugin that provides some useful tools for

creating a color image. In the menus, select Plugins — Color —RGB Composer.
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3. Select the appropriate image for each color. In the RGB Composer popup

window, select which image you want to use for the red, green, and blue portions
of your image. (R=red, B=blue, V=green [think ‘verde' in Spanish])

. Adjust the brightness and contrast of each image. You are experienced at this.
The only differences from our previous ImageJ work are (1) the RGB Composer
contains the brightness and contrast dialog for each color, and (2) since we took
the logarithm of the images, the ranges are much smaller. The goal is to bring
out as much of the faint structure as possible, while making sure that the sky is
black and structures are not washed out. You will have different ranges for
each color. It's helpful fo keep notes in case you need to start over.

A good starting point is to run the cursor around your three logarithmic FITS

images and look at typical values in the sky, and set this fo your min value. Then
add 2 or 3 for the max value. Then click "Update” in the RGB Composer.
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Next, click on the brightness, contrast, upper and lower buttons to adjust
individual colors. Don't hesitate to zoom in on your object, and go for what
looks pretty!

Here are my final values and the resulting image:

P

) ) | RGB Composer

M16R fits s W[ Mmi6v.fits B $
[ e ~000in

Brightness

Contrast

<<
>
>
2

—_—

-

Upper i 3 - - Upper : -
-_—

Lower % & ! UNRD S { ). Lower

MO0 RGB-Composed Image (25%)
2042x2045 pixels; RGB; 16MB

Page 31



Some tips:

If the sky, which should be black, has a tint to it, go to that color and click
on the increase the Lower ">|" button until the sky is devoid of that color.
Some images may not have a black sky background if there is a lot of gas and
dust scattered throughout.
If the picture looks like it has too much of one color (like all the stars are
red or green), go to that color and increase the Upper value by clicking on
the "[>" button until things look right.
If the picture seems to be lacking a color (say the picture looks yellowish,
meaning it is lacking blue):
o If bright things are yellowish but faint things are okay, try
decreasing the Upper blue value with the "|<" button
o If faint things look yellowish but brighter things are okay, decrease
the Lower blue value by clicking on the “<|" button
In pictures of galaxies or nebulae, most background stars should be white in
color, though some may be reddish or blue.
In pictures of star clusters, you may want to try very narrow color ranges in
order to bring out the differences in star colors.
At some places in your color image, you may see individual pixels, round
spots, or even small lines of just one color (pure red, pure green, or pure
blue). These are likely cosmic rays, where charged particles hit the CCD in
random spots during one image. There are clever but complex ways to get
rid of these, and they affect a small percentage of pixels, so we left them in
your images.
For your color stacking to work, the images need to be aligned, meaning that
all the stars appear on the same pixels. We've aligned the 0.8-meter images
for you, but images from the web or your own telescope may not be aligned.
o Inunaligned images, if you zoom in on a
star, you will see each star as three
points; a red, green, and blue dot. If
they overlap somewhat, you may see a
white star with colors on the fringe:
o Use the "up”, "down”, “left” and "right"
buttons in the RGB composer to align
the star image the best you can.
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e For star clusters, the colors can be enhanced by de-focusing the image.
This spreads the light from a star over more pixels, giving your eye more
pixels from which to get the color). In ImageJ, try the Gaussian blur filter
(Process —Filters —Gaussian Blur) with a radius of 3 pixels. You'll have to
re-adjust the brightness and contrast, and you'll lose the faintest stars.

e Before running the RGB Composer, compare the pictures in the individual
filters. Do you notice obvious differences that can help you in adjusting the
color balance? For example, in many planetary nebulae, red is visible far
from the center, while green and blue only visible toward the center. In this
case, you may want your final image to look white or even blueish toward the
center.

6. Save your color image. Call it what you would like, say, M16_color. You'll be
asked fo choose an image format; I'd suggest choosing Tiff, Jpeg, or PNG.
TIFF gives you the best overall image, but it can be a gigantic file. PNG has
good fidelity and is smaller in size than TIFF. JPEG gives the smallest image
size, but at the expense of some image quality. Typically, T use PNG for
personal use, and JPEG for pictures T'll put on the web or in emails. You can
always save multiple copies in different formats!

That's it! If you aren't happy with your image, try again. Below are three different
attempts at making a color image from these Messier 16 images. Each has some
good points and some bad points. But, most importantly, none of these images is
wrong, or even fundamentally different. The only differences are in the stretches,
and different stretches bring out different features of the nebula.

Now give it another shot with the Whirlpool Galaxy (M51). Download the R, B, and V
fits images from the website.
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Answer Key
Lessons 1 to 3 and the Observing Challenge

This document provides answers to the questions posed in the ImageJ lessons.
Descriptive questions with no set answers are not covered below.

Lesson 1: Digital Picture Basics
Step 4

o Inwhich direction does the x coordinate increase? X pixel
coordinates increase to the right.

o They coordinate? The y coordinates increase down. This is
opposite to most conventions.

Step 7

o What pixel values correspond to dark areas? Small values (near
zero)

o What values to light areas? High values, near 255.

Some questions to think about

o Why do astronomers like this property? Astronomers want to be
able to measure the amount of light (i.e., count photons) from stars
and galaxies. The pixel value is proportional to the number of
photons detected. If adjusting the brightness and contrast were
to change the pixel value, we would not be able to make those
adjustments without losing the astronomical information.

o How can you use ImageJ to see these stars? You will need to set
the maximum displayed pixel value closer to the faint stars' pixel
values. A maximum of 155 would display the faint stars best,
though they would still be visible with higher maxima (such as 300
or 400).

Lesson 2: Opening an Astronomical Image
Step 3
o What can you do to make fainter pixels easier to see? Lower the
maximum displayed pixel value.
Step 4
o Can you see the five galaxies now? Approximate (x,y) coordinates of the galaxy
centers are: (490, 370), (660, 475), (713, 478), (483, 640) and (870, 684).
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Lesson 3: Measuring Star Brightnesses
Additional questions and exercises for the diligent student
1. What would happen to your number of counts if the camera
shutter had been open twice as long? The counts would double.
Likewise, if the exposure had been half the length, the counts
would be halved.

Appendix
Useful Websites
* An Introduction to Astronomical Image Processing With ImageJ, a handbook

to many astronomical uses of ImageJ, as well as links to additional resources:
www.astro.physik.uni-goettingen.de/~hessman/ImaqgeJ/Book/

* The ImageJ Homepage, where you can download the latest version of ImageJ:
http://rsbweb.nih.gov/ij/

*_ Dr. Frederic Hessman's Astronomy Plugin Tools for ImageJ, the plugin toolset we
have incorporated into ImageJ:
www.astro.physik.uni-goettingen.de/~hessman/Imaged/Astronomy/
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